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Introduction 

This manual has been prepared to document the general accounting duties performed by small-medium sized 

businesses.  The basic purpose of the General Accounting Manual is to provide you with direction and guidance 

in connection with those accounting transactions, procedures, and reports that should be uniform throughout the 

company. 

Its intention is to ensure that assets are safeguarded, financial statements are in conformity with generally 

accepted accounting principles, and that finances are managed with responsible stewardship.   

The information contained in this document is subject to change without notice. If you find any problems in the 

documentation, please report them to me in writing. This document is not warranted to be error-free. Except as 

may be expressly permitted in your license agreement for these Programs, no part of these Programs may be 

reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose. 

If you find any errors or have any other suggestions for improvement, please indicate the title and part number 

of the documentation and the chapter, section, and page number (if available). You can send comments to us by 

e-mail at:  maryannwallner@gmail.com  

If you would like a reply, please give your name, address, telephone number, and electronic mail address 

(optional). 
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Checklist for Creating a New Company 

 Fiscal Year 

 Tax year 

 Fax Form 

 Start Date:  at the beginning of a month, a quarter, or your fiscal year or “the last day of the 

prior period” 

 Accrual or Cash 

 Federal EIN # 

 State ID # 

 Chart of Accounts 

 Get from Accountant 

 Customers 

 Check for any existing balances 

 Payment Terms 

 Vendors 

o Find my account number 

o Payment Terms 

o Outstanding Bills 

 Items 

o An item is anything that your company buys, sells, or resells in the course of business, such as products, 

shipping and handling charges, discounts, and sales tax. You can think of an item as something that shows up 

as a line on an invoice or sales form.  

o Items help you fill out the line item area of a sales or purchase form quickly. When you choose an item from 

your Item List, QuickBooks fills in a description of the line item and calculates its amount for you. 

 

Set up a separate company file for each tax return you will file. 

 

 



 
 

Enter Historical Transactions 
If your start date is before today's date, you'll need to enter past (or historical) transactions. This ensures that your 

QuickBooks records will be completely up-to-date from your start date forward. 

 

The order in which you enter historical transactions is important. You must enter them in sequential order. For 

example, QuickBooks won't know how to credit a customer payment unless you've previously recorded the invoice to 

that customer. 

 

Enter transactions in your bank account last, because your accounts payable and accounts receivable affect your bank 

account. By the time you enter all of your historical transactions, your check register will be mostly up to date. 

Enter your transactions in this order: 

   Invoices you've sent out since your start date 

   Purchase orders you've issues since your start date that you haven't received in full 

   Cash or checks you've received since your start date 

   Bills you've received since your start date 

   Bills you've paid since your start date 

   Deposits you've made to any of your accounts since your start date 

   Any other checks you've written (for things other than bills) since your start date  

 

If you don't have time to enter all your historical transactions right away, don't worry. You don't have to enter all your 

past transactions before you start using QuickBooks for your current transactions. Start entering current transactions as 

they occur, so you don't get behind. Then catch up with historical transactions when you can.  

 

If current and historical transactions are related, enter the earlier one first. For example, if you receive a payment 

today for an invoice you have not yet entered, enter the invoice first and then use QuickBooks to record the payment. That 

way, QuickBooks correctly links your transactions to each other.  

 

Remember, though, that your account balances will be incorrect (and your reports may be wrong) until you've 

entered all the past transactions!! 

 

  



 
 

Types of Accounts in QuickBooks 
 

Account Type Example Normal Balance 

Bank Checking Debit 

Accounts Receivable Accounts Receivable Debit 

Other Current Asset Prepaid Rent Debit 

Fixed Asset Depreciable Equipment Debit 

Accounts Payable Accounts Payable Credit 

Credit Card Visa Credit 

Other Current Liability Short-Term Loan Credit 

Long Term Liability Auto Loan Credit 

Equity Retained Earnings Credit 

Income Sales Credit 

Cost of Goods Sold Cost of Goods Sold Debit 

Expense Telephone Expense Debit 

Other Income* Interest Income Credit 

Other Expense* Corporate Taxes Debit 

 

 

 

*Other income and other expense accounts are used to track income and expenses that are not 

the result of normal day to day business operations. 

  



 
 

Complete Your Bank Account Information 

Once you've entered your historical transactions, your account registers will contain entries reflecting bills 

you've paid, checks you've written, and deposits you've received. To make your account registers complete, you 

must also enter these transactions: 

 Checks or other charges that happened before your start date but didn't appear on statements before your 

start date 

 Other checks you wrote after your start date that were not for bills or accounts payable (for example, credit 

card payments) 

 Deposits you made after your start date that were not customer deposits 

 Deposits you made before your start date, but which didn't appear on statements before your start date 

 Bank charges and fees 

 Interest paid on your account 

Complete your customer, vendor, and items lists 

Items are goods, services, or other things that you buy or sell. When you selected a predefined company file or 

completed the EasyStep Interview, QuickBooks created an Items List for you. Now you need to add the rest 

of your items to this list so that it accurately reflects the services and products for your business. 

First, through the use of Pre-Made forms or templates (invoices/bills) enter all open transactions for your 

customers and vendors.  

Next, enter additional information that is necessary or useful for your type of business, like addresses, phone 

numbers, and credit limits. You might not need to add all of this information for all customers and vendors. You 

can add this information gradually, over time; you don't need to add it all at once. 

  



 
 

 

 

 

 

  



 
 

Understanding Financial Statements 

Financial statements (or financial report) are records of the financial activities of a business. 

"The purpose for these financial statements is to provide information about the financial position, performance 

and changes in financial position of an enterprise that is useful to a wide range of users in making economic 

decisions.  The financial goal for your business is to yield high rate of return for your money but in order to 

maintain this control all companies must start with a comprehensive record-keeping system (in your case 

QuickBooks) that produces thorough accounting records. 

For a business, all the relevant financial information, presented in a structured manner and in a form easy to 

understand, are called the financial statements. They typically include three basic financial statements: 

1. The Profit & Loss  (Income Statement) 

2. The Balance Sheet 

3. Statement of Cash-Flows  

  



 
 

*Profit and Loss Statement which is also referred to as Income Statement provides 

information on the company's income, expenses, and profits over a period of time usually one 

quarter or one year.  The accounts which feed the Profit and Loss Statement provide 

information on the operation of the business and measures economic performance. 

 

 

 

 

 

 

 

 

 

 

  

Profit & Loss  

accounts 

Income 

Sales 

Delivery Fees 

Interest 

Expense 

Supplies 

Rent 

Utilities 



 
 

*Balance Sheet provides information regarding the company’s financial condition and reports 

on a company's assets, liabilities, and ownership equity at a given point in time.  The accounts 

which feed the Balance Sheet gives the business owner (s) a snapshot of their businesses 

financial position and tracks accumulated net wealth. 

 

 

 

 

 

 

 

 

 

 

 

 

  

Balance Sheet  

Accounts 

Assets 

Bank account 

Accounts receivable 

Equipment 

Liability 

Accounts payable 

Credit Cards 

Sales tax payable 

Loans 

Equity 

Capital Investment 

Retained Earnings 



 
 

*Statement of Cash Flows reports on a company's actual flow of cash through your 

business and summarizes the operating, investing, and financial activities as they relate to 

the inflow and outflow of cash.  The Statement of Cash Flow charts a business’ performance 

over a specific accounting period of time.   

 

 

  

17% 

33% 

50% 

Cash Flows from Financial Activities 

Increase (decrease) in cash 

Beginning Cash Balance 

Net Cash Balance 

http://en.wikipedia.org/wiki/Statement_of_cash_flows


 
 

Understand What Normal Balance Means 

Normal balance is the accounting classification of an account. It is part of Double-entry bookkeeping 

technique.  

Every account has either credit or debit Normal Balance.  Therefore, in order to: 

 Increase the value of an account with Normal Balance of credit, one would credit the account 

 Increase the value of an account with Normal Balance of debit, one would likewise debit the account  

Using this accounting principle – if someone invests cash into a business, the business records the financial 

transaction as a: 

 Debit to Cash (an increase to cash)  

 and 

 Credit to Capital (an increase to capital) 

The fundamental accounting equation is the following:  

Asset = Liability + Equity 

The account on left side (Asset) of this equation has a Normal Balance of debit. The accounts on right side 

(Liability + Equity) of this equation have a Normal Balance of credit. The Normal Balance of all other 

accounts is derived from their relationship with these three accounts.  

Normal Balance of common accounts:  

 Asset: Debit  

 Liability: Credit  

 Shareholder Equity: Credit  

 Revenue: Credit  

 Expense: Debit  

 Retained Earnings : Credit  

 Dividend: Debit  

The double-entry bookkeeping system refers to a set of rules to record financial information.  In our modern 

accounting system this “double-entry system” is done using debits and credits, and serves as a kind of error-

detection system: if, at any point, the sum of debits does not equal the corresponding sum of credits, then an 

error has occurred. 

For the accounts to remain in balance, a change in one account must be matched with a change in another 

account. These changes are made by debits and credits to the accounts and since the accounts must always 

balance, for each transaction there will be a debit made to one or several accounts and a credit made to one or 

several accounts. The sum of all debits made in any transaction must equal the sum of all credits made.  

In other words, after posting a series of transactions, the sum of all the accounts with a debit balance will equal 

the sum of all the accounts with a credit balance. 

http://www.economicexpert.com/a/Accounting.htm
http://www.economicexpert.com/a/Double:entry:book:keeping.htm
http://www.economicexpert.com/a/Credit.htm
http://www.economicexpert.com/a/Debit.htm
http://www.economicexpert.com/a/Asset.htm
http://www.economicexpert.com/a/Liability.htm
http://www.economicexpert.com/a/Shareholder:Equity.htm
http://www.economicexpert.com/a/Revenue.htm
http://www.economicexpert.com/a/Expense.htm
http://www.economicexpert.com/a/Dividend.htm
http://en.wikipedia.org/wiki/Debits_and_credits
http://en.wikipedia.org/wiki/Debits_and_credits


 
 

Understanding the Importance of the Chart of 

Accounts 
The Chart of Accounts contains a complete list of your business's accounts and their balances.  It is used to 

track: 

 How much money your company has; 

 How much money it owes; 

 How much money is coming in; 

 How much is going out. 

They include assets like bank accounts, buildings, and money that people owe you; they also include liabilities 

like credit cards or loans from banks. 

Another category of Balance Sheet Accounts is Equity Accounts. These represent the worth of your business 

including any investments the owners have made in the company. Your company's equity is all of your assets 

(what you own) minus your liabilities (what you owe). This is sometimes called the "net worth" of your 

company.  

Types of Accounts in the Chart of Accounts 

There are two main types of accounts in the QBs Chart of Accounts: 

 Balance Sheet Accounts 

 Income and Expense Accounts 

  

ms-its:C:/Program%20Files/Intuit/QuickBooks%202007/accounts_n.chm::/balance_n/glossary_balance.html
ms-its:C:/Program%20Files/Intuit/QuickBooks%202007/accounts_n.chm::/chart_n/income_n.chm::/sales_n/glossary_incacct.html
ms-its:C:/Program%20Files/Intuit/QuickBooks%202007/accounts_n.chm::/chart_n/expenses_n.chm::/gloss_n/glossary_expacct.html


 
 

Balance Sheet Accounts 

QuickBooks provides ten types of Balance Sheet Accounts to choose from as you create and add to your chart 

of accounts. The following table describes each type of Balance Sheet Account and the transactions you can 

use it for. 

The Balance Sheet Accounts have a register which contains the information.  To open any Balance Sheet 

Account (except Retained Earnings) Double-Click on it. 

Account Type Used to Track 

Bank Checking, savings, and money market accounts. Add one bank account for every 

account your company has at a bank or other financial institution. (You can also use this 

type for petty cash.) 

Accounts 

Receivable (A/R) 

Transactions related to the customers that owe you money, including invoices, 

payments, deposits of payments, refunds, credit memos, and statements. Most 

companies have only one A/R account. 

Other current 

asset 

Assets that is likely to be converted to cash or used up within one year, such as petty 

cash, notes receivable due within a year, prepaid expenses, and security deposits. 

Fixed asset Depreciable assets your company owns that aren't likely to be converted into cash 

within a year, such as equipment or furniture. 

Other asset Any asset that is neither a current asset nor a fixed asset, such as long-term notes 

receivable. 

Accounts payable 

(A/P) 

Transactions related to money you owe, including bills, bill payments, and any credit 

you have with vendors. See also current and long-term liability accounts. 

Credit card Credit card purchases, bills, and payments. 

Current liability Liabilities that are scheduled to be paid within one year, such as sales tax, payroll taxes, 

accrued or deferred salaries, and short-term loans. 

Long-term 

liability 

Liabilities such as loans or mortgages scheduled to be paid over periods longer than 

one year. 

Equity Owner's equity, including capital investment, drawings, and retained earnings. 

 

  



 
 

Profit and Loss Accounts 

Profit & Loss or “Income” and “Expense” Accounts track the sources of your income and the purpose of 

each expense. When you record transactions in one of your Balance Sheet Accounts, you usually assign the 

amount of the transaction to one or more income or expense accounts. For example, not only do you record that 

you took money out of your checking account, but you keep track of what you spent the money on: utilities, 

perhaps, or office supplies. 

NOTE:  QBs does not display balances for Income and Expense Accounts in the Chart of Accounts.  

 To see these balances, go to the Reports menu, choose Company & Financial, and then click one of 

the Profit And Loss Report options.  

 You can also select the Income or Expense Account in the chart of accounts and click QuickReport. 

Use this 

account 

Used to Track 

Income The main source of money coming into your company. 

Other 

income 

Money received for something other than normal business operations, such as interest income. 

Expense Money that's leaving your company. 

Other 

expense 

Money spent on something other than normal business operations, such as corporate taxes. 

Cost of 

Goods sold 

 The direct costs attributable to the production of the goods sold or service by a company.  

 The cost of goods and materials held in inventory and then sold. 

 

  



 
 

USING ACCOUNT NUMBER IN QUICKBOOKS 

Adding Account Numbers to Your Accounts 

You can set a preference that allows you to add an account number to each account you set up in your chart of 

accounts. Although you're not required to use account numbers in your QuickBooks chart of accounts, your 

accountant may recommend that you do so. 

When you assign an account number to a new account, QuickBooks inserts the number before the account name 

in the chart of accounts. The account number also appears in reports that list the account and on graphs.  

Here are standard chart of accounts number ranges:  
10000 - 19999 Assets 

20000 - 29999 Liabilities 

30000 - 39999 Equity 

40000 - 49999 Income or Revenue 

50000 - 59999 Job Costs/Cost of Goods Sold 

60000 - 69999 Overhead Costs or Expenses 

70000 - 79999 Other Income 

80000 - 89999 Other Expense 

The five digits provide some growing room when new accounts need to be sandwiched into the list in the right 

order.  The five digits are used as follows: 

 The 1
st
 digit is the high level account type (asset, liability, etc.) 

 The second 2 digits are used in account numbering 

 The last 2 digits are used in subaccount numbering 

To Turn On The Preference For Using Account Numbers:  

1. Go to the Edit menu and click Preferences. 

2. In the Preferences window, click Accounting preferences in the list on the left. 

3. Click the Company Preferences tab. 

4. Select the Use account numbers checkbox. 

5. Select the Show lowest subaccount only checkbox. 

6. Click OK. 

Using Account Numbers 

1. Start entering in the Account Number or Name  (Invoices or Bills) 

2. Once you view the appropriate account number Left Click selected number 

from the list to “Autofill”.  

I suggest that you print 

the Chart of Accounts 

and post them by your 

computer – for easy 

reference. 



 
 

SAMPLE CHART OF ACCOUNTS 

Account 

Number NAME Account Type Description 

10000 Checking Account Bank   

10100 Payroll Account Bank   

11000 Investment Account Other Current Assets   

12000 Undeposited Funds Other Current Assets   

13000 Accounts Receivable Accounts Receivable   

14000 Prepaid Expenses Other Current Assets   

14010 Prepaid Expenses: Prepaid Rent Other Current Assets   

14020 Prepaid Expenses: Prepaid Legal Fees Other Current Assets   

14030 Prepaid Expenses: Prepaid Insurance Other Current Assets Prepaid Insurance 

17000 Deposits Other Current Assets Refundable Deposits 

15000 Computers & Software Fixed Asset   

15010 Furniture & Fixtures Fixed Asset 

Furniture and equipment with useful 

life exceeding one year 

15020 Major Equipment Fixed Asset   

15030 Leaseholds Improvements Fixed Asset   

15040 Company Vehicles Fixed Asset   

15050 Website Programming Fixed Asset   

16000 Accumulated Depreciation Fixed Asset 

Accumulated depreciation on 

equipment, buildings and 

improvements 

20000 Accounts Payable Accounts Payable   

20050 Business Credit Card Credit Card   

20100 Accrued Liabilities Other Current Liability   

20200 Taxes Payable Other Current Liability   

21000 Line of Credit Other Current Liability   

24000 Payroll Liabilities Other Current Liability   

25000 Bank Loan Long Term Liability   

30100 Capital Stock Equity Value of corporate stock 

30000 Additional Paid in Capital Equity   

32000 Retained Earnings Equity 

Undistributed earnings of the 

business 

31400 Shareholder Distributions Equity Distributions paid to shareholders 

40000 Main Services Income   

40010 Main Services: Type 1 Income   

40020 Main Services: Type 2 Income   

41000 Secondary Service Income   

41010 Secondary Service:2nd Type 1 Income   

50000 Direct cost of Main Services1 Cost of Goods Sold   

50100 Direct cost of Main Services2 Cost of Goods Sold   

50200 Direct cost of Main Services3 Cost of Goods Sold   

50210 Direct cost of Main Services4 Cost of Goods Sold   

51000 Direct cost of Secondary Services1 Cost of Goods Sold   

51010 Direct cost of Secondary Services2 Cost of Goods Sold   

51020 Direct cost of Secondary Services3 Cost of Goods Sold   



 
 

51030 Direct cost of Secondary Services4 Cost of Goods Sold   

52000 Direct cost of Secondary Services5 Cost of Goods Sold   

60000 Advertising and Promotion Expense 

Advertising, marketing, graphic 

design, and other promotional 

expenses 

60010 Advertising and Promotion: Website Expense   

60020 

Advertising and Promotion: Pay-per-

click advertising Expense   

60030 Advertising and Promotion: Print Media Expense   

60040 Advertising and Promotion:PR Expense Public Relations Firm 

60100 Misc Sales & Marketing Expenses Expense   

61000 Depreciation Expense Expense 

Depreciation on equipment, 

buildings and improvements 

61005 

Depreciation Expense: Computer & 

Software Expense   

61010 

Depreciation Expense: Furniture & 

Fixtures Expense   

61020 Depreciation Expense: Major Equipment Expense   

61030 

Depreciation Expense: Leasehold 

Improvements Expense   

61040 

Depreciation Expense: Company 

Vehicles Expense   

61200 Insurance Expense Expense Insurance expenses 

61210 

Insurance Expense: General Liability 

Insurance Expense General liability insurance premiums 

61220 

Insurance Expense: Life and Disability 

Insurance Expense 

Employee life and disability 

insurance premiums 

61230 

Insurance Expense: Professional 

Liability Expense 

Professional liability (errors and 

omissions) insurance 

61240 

Insurance Expense: Worker’s 

Compensation Expense 

Worker's compensation insurance 

premiums 

61250 Insurance Expense: Health Insurance Expense   

61300 Meals and Entertainment Expense 

Business meals and entertainment 

expenses, including travel-related 

meals 

61310 Postage and Delivery Expense 

Postage, courier, pickup & delivery 

services 

61320 Printing and Reproduction Expense 

Printing, copies, and other 

reproduction expenses 

61500 Office Supplies Expense Office supplies expense 

61550 Small Furniture & Equipment Expense 

Furniture and Equipment with useful 

life less than a year 

61560 Equipment Maintenance & Repairs Expense   

61900 Bank Service Charges Expense 

Bank account service fees, bad check 

charges and other bank fees 

61910 Payroll Fees Expense   

61950 Business Licenses and Permits Expense 

Business licenses, permits, and other 

business-related fees 

62000 Rent Expense Expense 

Rent paid for company offices or 

other structures used in the business 

65000 Payroll Expenses Expense   

65010 Payroll Expenses: Management Salaries Expense   

65020 Payroll Expenses: Staff Salaries Expense   

65030 Payroll Expenses: Payroll Taxes Expense   

65040 Payroll Expenses: Employee Benefits Expense   



 
 

65100 Computer Expenses Expense 

Computer supplies, off-the-shelf 

software, online fees, and other 

computer or internet related 

expenses 

65110 

Computer and Internet Expenses: 

Computer peripheral Expense Non-capitalized computer equipment 

65120 

Computer and Internet Expenses: 

Software expense Expense non-capitalized software 

65150 Utilities Expense Water, electricity, garbage, etc. 

65160 Internet Access Expense   

65170 Telephone Expense Expense 

Telephone and long distance 

charges, faxing, and other fees Not 

equipment purchases 

65130 Cell Phone Expense Expense   

65200 Automobile Expense Expense 

Fuel, oil, repairs, and other 

automobile maintenance for business 

autos 

65200 Continuing Education Expense 

Seminars, educational expenses and 

employee development, not 

including travel 

65250 Dues and Subscriptions Expense 

Subscriptions and membership dues 

for service, professional, trade 

organizations 

65600 Travel Expense Expense 

Business-related travel expenses 

including airline tickets, taxi fares, 

hotel and other travel expenses 

65610 Travel Expense: Lodging Expense   

65620 Travel Expense: Meals Expense Meals on business trips 

65630 Travel Expense: Mileage Expense   

66200 Professional Fees Expense Payments for services rendered 

66210 Professional Fees: Accounting Expense   

66220 Professional Fees: Legal Expense   

66230 Professional Fees: IT support Expense   

67200 Repairs and Maintenance Expense 

Incidental repairs and maintenance 

of business assets that do not add to 

the value 

69000 Charitable Contributions Expense 

Contributions to qualifying 

charitable organizations 

70000 Finance Charge Income Other Income 

Income from finance charges and 

late fees charged to customers 

70200 Interest Income Other Income 

Interest earned on bank accounts and 

loans 

79000 Interest Expense Other Expense Interest charged on loans 

 

 

 



 
 

 

 

  



 
 

How to Create the Balance Sheet Report 

To Create this report 

What this report tells you 

The Balance Sheet Report summarizes the financial 

position of a business. A balance sheet shows the value 

of your company's assets, liabilities, and equity as of a 

particular day. It is called a balance sheet because the value 

of the assets is always exactly equal to the combined value 

of the liabilities and equity. 

QBs offer four different preset balance sheet reports. You'll 

find these reports under Company & Financial on the Report 

Center or Reports menu. 

 

 

 

 

  



 
 

How to Create the Profit and Loss Standard Report 

To Create this report 

What this report tells you 

This report is also known as an income 

statement. It summarizes your income and 

expenses for the month, so you can tell 

whether you're operating at a profit or a loss. 

The report shows subtotals for each income 

or expense account in your chart of 

accounts. The last line shows your net income 

(or loss) for the month. 

To see a list of the transactions that make up an 

amount, double-click the amount. 

Date range 

The default date range is for the current month 

to date. You can show profit and loss for a 

different date range by choosing another date 

range from the Dates drop-down list. 

 

 

  

ms-its:C:/Program%20Files/Intuit/QuickBooks%202007/reports_n.chm::/rptdesc_n/income_n.chm::/sales_n/glossary_incacct.html
ms-its:C:/Program%20Files/Intuit/QuickBooks%202007/reports_n.chm::/rptdesc_n/expenses_n.chm::/gloss_n/glossary_expacct.html


 
 

How to Create the Cash Flow Report 

To Create this report 

What this report tells you 

 

A Cash Flow Statement shows changes of cash over time rather than absolute dollar amounts at a point in time. 

It shows the amount of cash earned from profit, where you received additional cash, and where your cash was 

spent.  Basically, a Cash Flow Statement can tell you whether the company generated cash. 

 

The report shows how much cash was provided or used by: 

 Operating Activities 

 Investing Activities 

 Financing Activities 

To see a list of the transactions that make up an amount, double-click the amount. 

Date range 

The report shows your cash flow for the fiscal year to 

date, but you can change the reporting period by 

choosing a different date range from the Dates drop-

down list. 

 

 

 

 

  

ms-its:C:/Program%20Files/Intuit/QuickBooks%202007/reports_n.chm::/rptdesc_n/popup_operating_activities.html
ms-its:C:/Program%20Files/Intuit/QuickBooks%202007/reports_n.chm::/rptdesc_n/popup_investing_activities.html
ms-its:C:/Program%20Files/Intuit/QuickBooks%202007/reports_n.chm::/rptdesc_n/popup_financing_activities.html


 
 

How to Create the Accounts Receivable Aging 

Summary Report 

To Create this report 

What this report tells you 

This report summarizes the status of unpaid invoices and statement charges in accounts receivable. For each 

customer who owes money, the report shows: 

 What the customer owes for the current billing period 

 What the customer hasn't paid from previous billing periods 

 Subtotal balances for each job (if the customer has multiple jobs with your company) 

To see a list of the transactions that make up a balance, double-click the balance in the report. 

 

Sample Report 

  



 
 

Date range 

The 1-30, 31-60, 61-90, and >90 columns show overdue balances from previous billing periods. For example, 

an amount in the 31-60 columns is between 31 and 60 days overdue. 

Changing the date range of a report 

All reports have a preset or "default" date range. You can change the date range to cover a different period of 

time. 

To change the date range for a report 

1. Open the report you want to modify. 

2. Define the date range to use: 

 Click the Dates drop-down list at the top of the report and choose a different date range. 

What do the different date ranges mean? 

To change to a period of time not specified by one of the preset ranges, click the calendars to change the 

dates shown in the From and To fields. When the calendar appears, click the arrows to display the month 

you want, then click the day of the month. 

  



 
 

How to Create the Open Invoices Report 

To Create this report 

What this report tells you 

This report lists unpaid invoices and statement charges, grouped and subtotaled by customer and job.  To see the 

detailed information for any transaction in this report, double-click on the transaction.   

 

Note: You can also display the open invoices for all customers on the Transactions tab of the Customer 

Center. 

Date range 

The report shows all open invoices as of the current date. 

 

Sample Report 



 
 

How to Create the Accounts Payable Aging 

Summary Report 

To Create this report 

What this report tells you 

It summarizes the status of unpaid bills in accounts payable, showing what you owe, who you owe it to, and 

how much is overdue. 

For each vendor to whom your company owes money, the report shows how much your company owes for the 

current and previous billing periods, and it shows the total amount. The report also shows the total amount owed 

to all vendors. 

 

Sample Report 

  



 
 

Date range 

Starting with today, and looking back for 90 days. The 1-30, 31-60, 61-90, and >90 columns show overdue 

balances from previous billing periods. For example, an amount in the 31-60 columns is between 31 and 60 

days overdue. 

 

 

  

See the above information for other changes to this report such as: 

 Changing the Date Range 

 What do different date ranges mean 



 
 

How to Create the Unpaid Bills Detail Report 

To Create this report 

What this report tells you 

This report shows all the bills and payments related to each vendor. The totals shown in the Balance column are 

your company's unpaid balances. If a bill is overdue, the Aging column shows the number of days past due. 

 

Sample Report 

  



 
 

 

 

 

 

 

  



 
 

QuickBooks Keyboard Shortcuts 
Activity Key 

Account List, display Ctrl + A 

Check, write Ctrl + W 

Customer: Job list, display Ctrl + J 

Delete Check, invoice, transaction, or items from list Ctrl + D 

Edit Lists or Registers Ctrl + E 

QuickFill and Recall (type few letters of name and 

press tab, name fills in) 

Abcxzy Tab 

Find Transaction Ctrl + F 

Go to register of transfer account Ctrl + G 

Help in context, display F1 

History of A/R or A/P Transaction Ctrl + H 

Invoice, Create Ctrl + I 

List (for current field, display Ctrl + L 

Memorize transaction or report Ctrl + M 

Memorized transaction list, display Ctrl + T 

New invoice, bill, check, or list item Ctrl + N 

Paste copied transaction in register Ctrl + V 

Print Ctrl + P 

QuickZoom on report Enter 

QuickReport on transaction or list item Ctrl + Q 

Register, display Ctrl _ R 

Use list item Ctrl + U 

Transaction Journal, display Ctrl + Y 
 

Moving Around A Window Key 

Next Field Tab 

Previous Field Shift + Key 

Report Column to the right Right arrow 

Report Column to the left Left arrow 

Beginning of current field or report row Home 

End of current field or report row End 

Line below in detail area or on report Down arrow 

Line above in detail area or on report Up arrow 

Down one screen Page Down 

Up one Screen Page up 

Next word in field Ctrl + Right Arrow 

Previous word in field Ctrl + Left Arrow 

First item on list or previous month in register Ctrl + Page Up 

List item on list or next month in register Ctrl + Page Down 



 
 

Close active window Escape or Ctrl + F4 

Move to Message area in Invoices Alt + M 
 

Dates Key 

Next day + (plus key) 

Previous day - (minus key) 

Today T 

First Day of the Week W 

Last Day of the Week K 

Last Day of the Month H 

First Day of the Year Y 

Last Day of the Year R 

Date calendar Alt + down arrow 
 

Editing Key 

Edit transaction in selected register Ctrl + E 

Delete charter to right of insertion point Del 

Delete charter to left of insert point Backspace 

Delete line from detail area Ctrl + Delete key 

Insert line in detail area Ctrl + Insert key 

Cut selected characters Ctrl + X 

Copy selected characters Ctrl + C 

Paste cut or copied characters Ctrl + V 

Increase check or other form number by one + (plus Key) 

Decrease check or other form number by one - (minus Key) 

Undo changes made in field Ctrl Z 
 

Access Menu buttons Key 

Banking Alt + B 

Company Alt + C 

Edit Alt + E 

File Alt + F 

Help Alt + H 

Lists Alt + L 

Moves Cursor to the Message area in an invoice Alt + M 

Vendor Alt + O 

Reports Alt + R 

Customer Alt + U 

View Alt + V 

Employee Alt + Y 
 



 
 

QuickBooks Resources 

 

I of course also use Intuit as a major resource for solving very difficult problems.  What is nice 

about Intuit is that they also have a blog on their site which helps users manage your company 

because the bloggers are the end users of this program and the answers come from other 

business owners or people who actually perform the work. 

Intuit provides the following types of support: 

Small Business Forums 

Starting & Growing Your Business 

The Future of Small Business  

Women Entrepreneurs Google 

Marketing Tools  

Small Business Experts  

 

Expert Assistance 

Educator's Corner Accountants  Bookkeeping IT Consultants  Small Business Experts 

QuickBooks Experts  

 

QuickBooks Tasks - Pro & Premier 

Banking Customizing Forms Fixed 

Assets Manager Importing & 

Exporting Data Installation, Update 

& Conversion Center Installation, 

Update & Conversion Forums  

Inventory Journal Entries & 

Accounting Tasks Paying Bills & 

Vendor Management Payroll Center 

Payroll Forums Performance Issues 

& Program Errors  

Printing Receiving Money & 

Managing Customers Reports 

Shipping Manager Working with 

the Data File  

 

Sign Up for their Newsletter at 

http://accountant.intuit.com/member_programs/proconnection/newsletter.aspx?lid=leftnav 

Finally, don’t forget, in the QuickBooks Program you have the following tools: 

1. “Help” button (located on the menu bar) 

 Help is used to search for specific topics. 

2. Videos 

 Before you get started, trying watching all the videos.  It will help build your 

confidence with the program. 

3. Sample Companies 

 Intuit has provided the ‘perfect’ company as one of your resources.  With them 

(service/product) you can see how to correct use the program. 

http://quickbooksgroup.com/.ee7be39!leftNavLink=biz
http://quickbooksgroup.com/.eeedd69
http://quickbooksgroup.com/.ef7becf
http://quickbooksgroup.com/.ef082e0
http://quickbooksgroup.com/.ef4c040
http://quickbooksgroup.com/.ef4c040
http://quickbooksgroup.com/.ef90333
http://quickbooksgroup.com/.ee7be39!leftNavLink=expert
http://quickbooksgroup.com/.ef00906
http://quickbooksgroup.com/.eee5c72
http://quickbooksgroup.com/.ef6a115
http://quickbooksgroup.com/.ef572d8
http://quickbooksgroup.com/.ef90333
http://quickbooksgroup.com/.eebc822
http://quickbooksgroup.com/.ee7be39!leftNavLink=tasks
http://quickbooksgroup.com/.ef1e8b6
http://quickbooksgroup.com/.ef1e8c4
http://quickbooksgroup.com/.eea2dcc
http://quickbooksgroup.com/.eea2dcc
http://quickbooksgroup.com/.ee8e2e6
http://quickbooksgroup.com/.ee8e2e6
http://quickbooksgroup.com/.efc750a
http://quickbooksgroup.com/.efc750a
http://quickbooksgroup.com/.ee8e2e8
http://quickbooksgroup.com/.ee8e2e8
http://quickbooksgroup.com/.ee8e2e9
http://quickbooksgroup.com/.ee8e2eb
http://quickbooksgroup.com/.ee8e2eb
http://quickbooksgroup.com/.ee8e2e0
http://quickbooksgroup.com/.ee8e2e0
http://quickbooksgroup.com/.ef98590
http://quickbooksgroup.com/.ee8e2ec
http://quickbooksgroup.com/.ef2066e
http://quickbooksgroup.com/.ef2066e
http://quickbooksgroup.com/.ee8e2e7
http://quickbooksgroup.com/.ee8e2e1
http://quickbooksgroup.com/.ee8e2e1
http://quickbooksgroup.com/.ef1e8a1
http://quickbooksgroup.com/.ef1e8af
http://quickbooksgroup.com/.ef1e88c
http://quickbooksgroup.com/.ef1e88c
http://accountant.intuit.com/member_programs/proconnection/newsletter.aspx?lid=leftnav


 
 

 

One of the sources I use to solve the problems in QuickBooks is CPA911.com. This organization provides 

solutions to very difficult and obscure problems in a way that even beginning users of QuickBooks can 

understand and implement.   

 

Article Categories 

o Accounting (4)  
o Accounting Savvy for Business 

Owners (4)  
o Accounts (5)  
o Banking (4)  
o Custom Fields (3)  
o Customers (18)  
o Employees (4)  
o Excel for Accountants 2nd Edition 

(1)  
o Excerpts (3)  
o Forms (2)  
o Installation (1)  
o Inventory (1)  
o Loan Manager (1)  
o Maintenance (1)  
o MS Excel (1)  
o News (1)  
o Payroll (1)  

o Polls (2)  
o Preferences (6)  
o Printing (1)  
o QuickBooks (46)  
o QuickBooks How To Articles (3)  
o QuickBooks How To Tips (14)  
o Reports (6)  
o Support (3)  
o Templates (2)  
o Transactions (4)  
o Updates (3)  
o Vendors (4)  

 Site Links 
o Home Page 
o Quickbooks 
o MS Excel 
o Accounting 
o Contact 

  

http://www.cpa911.com/wordpress/category/accounting/
http://www.cpa911.com/wordpress/category/excerpts/accounting-savvy-for-business-owners/
http://www.cpa911.com/wordpress/category/excerpts/accounting-savvy-for-business-owners/
http://www.cpa911.com/wordpress/category/quickbooks/accounts-2/
http://www.cpa911.com/wordpress/category/quickbooks/banking/
http://www.cpa911.com/wordpress/category/quickbooks/custom-fields/
http://www.cpa911.com/wordpress/category/quickbooks/customers/
http://www.cpa911.com/wordpress/category/quickbooks/employees/
http://www.cpa911.com/wordpress/category/excerpts/excel-for-accountants-2nd-edition/
http://www.cpa911.com/wordpress/category/excerpts/
http://www.cpa911.com/wordpress/category/quickbooks/forms/
http://www.cpa911.com/wordpress/category/quickbooks/installation/
http://www.cpa911.com/wordpress/category/quickbooks/inventory/
http://www.cpa911.com/wordpress/category/quickbooks/loan-manager/
http://www.cpa911.com/wordpress/category/quickbooks/maintenance-quickbooks/
http://www.cpa911.com/wordpress/category/ms-excel/
http://www.cpa911.com/wordpress/category/news/
http://www.cpa911.com/wordpress/category/quickbooks/employees/payroll/
http://www.cpa911.com/wordpress/category/polls/
http://www.cpa911.com/wordpress/category/quickbooks/preferences/
http://www.cpa911.com/wordpress/category/quickbooks/printing/
http://www.cpa911.com/wordpress/category/quickbooks/
http://www.cpa911.com/wordpress/category/quickbooks/quickbooks-how-to-articles/
http://www.cpa911.com/wordpress/category/quickbooks/quickbooks-how-to-tips/
http://www.cpa911.com/wordpress/category/quickbooks/reports-quickbooks/
http://www.cpa911.com/wordpress/category/quickbooks/support/
http://www.cpa911.com/wordpress/category/quickbooks/templates/
http://www.cpa911.com/wordpress/category/quickbooks/transactions/
http://www.cpa911.com/wordpress/category/quickbooks/updates/
http://www.cpa911.com/wordpress/category/quickbooks/vendors/
http://www.cpa911.com/index.php
http://www.cpa911.com/quickbooks.php
http://www.cpa911.com/ms-excel.php
http://www.cpa911.com/accounting.php
http://www.cpa911.com/contact.php
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QUICKBOOKS ONLINE BACKUP SERVICE  

The easy way to protect your critical business data. 

A virus, hardware failure, natural disaster or simple human error could wipe out your most important 

files. Now you can protect your data with QuickBooks Online Backup Service. 

Easy — Selecting files to back up is fast and easy. And you can retrieve your files from any computer 

with an Internet connection. 

Convenient — Backups run automatically on a schedule that you set. 

Safe and Secure — Your data is encrypted
1
 and stored identically at two unique data centers for 

maximum security. 

Pricing  

Pricing: 

Service Level Monthly Plan Annual Plan 

5 GB $4.95/mo $49.95/yr 

25 GB $14.95/mo $149.95/yr 

75 GB $24.95/mo $219.95/yr 

 

Here's where you'll find answers to commonly asked questions about choosing, upgrading and using 

QuickBooks software. If you need more information before making your purchase decision, please call us 

at (888) 729-1996.  

 What is QuickBooks Online Backup Service?  

 I already perform backups. Why do I need QuickBooks Online Backup Service?  

 Which storage plan is right for me?  

 Is QuickBooks Online Backup Service secure?  

 What versions of QuickBooks can I use with QuickBooks Online Backup Service?  

Q: What is QuickBooks Online Backup Service? 

A: QuickBooks Online Backup is a service that enables you to automatically backup your critical files 

to secure, remote locations using the Internet. You can select the files on your computer that are most 

important to you and then select a regularly scheduled backup that fits your schedule. You can then easily 

retrieve your data from any PC with an internet connection.  

Q: I already perform backups. Why do I need QuickBooks Online Backup Service? 

A: Even if you already back up your data, QuickBooks Online Backup offers these advantages:  

 Automatic, scheduled backups - get peace of mind knowing that your data is regularly backed up. 

http://quickbooks.intuit.com/product/add_ons/online_data_backup.jhtml?view=overview_faq#Q1#Q1
http://quickbooks.intuit.com/product/add_ons/online_data_backup.jhtml?view=overview_faq#Q2#Q2
http://quickbooks.intuit.com/product/add_ons/online_data_backup.jhtml?view=overview_faq#Q3#Q3
http://quickbooks.intuit.com/product/add_ons/online_data_backup.jhtml?view=overview_faq#Q4#Q4
http://quickbooks.intuit.com/product/add_ons/online_data_backup.jhtml?view=overview_faq#Q5#Q5
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 Offsite password-protected storage - protect your data from fires and natural disasters.  

 No CDs or tapes to manage - skip burning CDs and managing backup copies. 

 Internet-based service - access your files from any PC with an internet connection.  

Q: Which storage plan is right for me? 

A: That will depend on the size of your QuickBooks company file and how much other data you wish to 

backup. To determine the size of your QuickBooks company file, open the file in QuickBooks and press 

F2. 

The 5 GB storage plans will allow you room to backup your company file (most QuickBooks company 

files are well under 1 GB) and a few other key documents or files. 

The 10 GB Storage Plan provides you with more storage to back up other documents and files that are 

important to you and your business. 

Note: QuickBooks Online Backup Service will not automatically backup media files such as MP3s, or 

MPG movie files.  

Q: Is QuickBooks Online Backup Service secure? 

A: Absolutely! QuickBooks Online Backup Service encrypts your data using bank level security 

procedures before transferring over the Internet to data centers. Your data, which is always protected by 

your password, is mirrored identically on two different servers at two unique data centers to protect from 

geographical disasters.  

Q: What versions of QuickBooks can I use with QuickBooks Online Backup Service? 

A: QuickBooks Online Backup can work independently from QuickBooks. However, if you have 

QuickBooks 2007 you can launch the tool from within QuickBooks and your company file will be pre-

selected 
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Creating Portable Company Files and 

Backup File 

What is a Portable File 

A portable company file is a compact version of your company file containing only financial 

data, and is small enough to be sent by e-mail or saved to portable media. You can use a portable 

company file whenever you need to move your company financial data to another location or 

send it to another person. 

Procedure for creating a Portable Company File 

1. Choose File > Save Copy or Backup from the menu bar 

2. Choose Portable company file, and then click Next 

3. Choose the location in which to store the portable company file, and then click Save 

4. Click OK to Allow QBs to close and reopen your file 

5. Click OK to acknowledge the portable company file creation 

What is a Backup File 

A backup file is a compressed file containing everything you need to recreate your company 

file and QBs environment. Use a backup file to safeguard your QBs files against accidental data 

loss. 

The backup file is saved with a .QBB extension. 

To keep your company file operating correct the Internal QBs backup procedure must be used 

periodically.  These internal processes that take place during the Backup Process which MUST 

be performed or the company file will begin to run more and more slowly. 

Procedure for creating a Backup Company File 

1. Choose File > Save Copy or Backup from the menu bar 

2. Choose Backup copy company file, and then click Next 

3. Choose the location in which to store the backup company file either Local backup or 

Online Backup 
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 It is very important to save the backup version to a folder that does not contain your 

regular company file such as a CD or a USB Flash drive or to a folder on your 

network 

 

 

 

 

 

4. Click Options to make sure where the backup is going to be stored.  The Backup Options 

window opens 

 

5. Click the Browse button and navigate to the desired folder window 

6. Click OK 

7. Leave the other defaults as they are.  You may see a window that looks like the below image: 

 

8.  It happens when QBs has detected that you are not backing up the file to another drive, and 

is recommending that you do so.  Just ignore the window and click Use this Location 
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9. Click Next, choose Save it now, and click Next again 

10. Choose Save it now.  Click Next.  QB wants to verify your backup location. 

 

11. It should show you the location in the Save in box since that is what you selected previously.  

Click Save.   

 QKs will now verify your data integrity 

 

 Assuming the data is stable, you will receive a confirmation message that the backup has 

been saved 

 

12. Click OK 
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How to Restore a Backup Company file 

If your backup file is not on your hard disk or in a network folder, insert the CD, USB flash 

drive, or other storage device in the appropriate drive. 

1. Go to the File menu and click Open or Restore Company to open the restore wizard. 

2. Click Restore a backup copy (.qbb) and then click Next. 

3. Click Local backup and then click Next. The Open Backup Copy window opens. 

4. If needed, click the Look in drop-down arrow and navigate to the location where you 

saved the backup file, which has a .qbb file extension (for example, 

mycompanyname.qbb). 

5. Select the backup file and click Open. 

6. Click Next. 

7. If needed, click the Save in drop-down arrow and navigate to the location where you 

want to restore the backup file.  

8. Select the backup file, click Save, and respond to any messages QBs may display. 

The company file is converted to a regular company file, with a .qbw extension (or a .qba 

extension if the backup was made from an Accountant's Copy). The company file and all 

of its related files are stored in this location. 

 

  

Important Information about Backing up 

The backup process is cumulative, from the beginning 

date of when you started using QKs up until the time the 

backup was created 

javascript:
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Troubleshooting Slow Performance 

If performance becomes an issue or you decide you do not want to keep detailed transactions for 

prior years, you can "condense" a QuickBooks data file using the Clean Up Data utility. If you 

find that QuickBooks is getting slow when entering or recording transactions, you might want to 

check the following: 

Is the Hard Disk Almost Full? 

If your hard disk gets too full, you’ll begin to notice that your whole system tends to run slower.  

A general rule for maintaining your hard disk performance is to keep at least 10% of the size of 

the hard drive free. So, a 2GB hard drive should always have at least 200MB free. 

Delete any unneeded data files, and uninstall unused programs. Make sure you always use the 

Add/Remove Programs control panel to remove programs from your computer. NEVER delete a 

program from the Windows Explorer as this will cause problems in your Windows registry. 

Is the Audit Trail Active? 

In QuickBooks, the Audit Trail is always on, so there is no way to change this preference. In 

earlier versions, you can disable the Audit Trail (not recommended). 

Is “Automatically Recall Last Transaction for This Name” Active? 

From the Edit menu choose Preferences. Choose General from the left area of the Preferences 

window. If the “Automatically recall last transaction for this name” option is selected, you can 

increase performance slightly by turning it off. This option requires QuickBooks to search 

backward for the last transaction using the payee name. If the register contains a large number of 

transactions, this can slow data entry. 

Are Several Reports Open? 

If you have reports open and the Reports & Graphs preference is set to “refresh automatically,” 

the open reports automatically recalculate each time you add new transactions. 

To improve the performance, either close all open reports, and/or turn off the “refresh 

automatically” preference in the Reports & Graphs preferences. 
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Is the Data File Too Large? 

If your data file is too large, performance will suffer. Generally, you should keep QuickBooks 

data files under 100MB or so. This is not an actual limit, but a general guideline for keeping 

things working smoothly and performance is a big part of that. If the file is nearing the 100MB 

range, you may want to condense the file or set up a new file. 

Use F2 to Check Details of Your Software 

If you need to know details about your QuickBooks version, or about the size of your company 

file, press F2. This is particularly useful if you need to know how large the data file is, how 

many transactions are in the file, or what release level of QuickBooks you are running. 

1. Launch QuickBooks and open your company file.  

2. Press F2. 
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Importing/Exporting QuickBooks 

Information 

Importing Pertinent Data into QuickBooks 

A text file that transfers list, budget, and transaction data to a QuickBooks company file. An exported or 

imported file must conform to a specific structure for QuickBooks to interpret the data in the file 

correctly. 

About importing data from an Excel or CSV file 

You can import lists of customers, vendors, accounts, or items into QuickBooks. Data that you 

import can be used to add new records to your QuickBooks lists or update existing records. 

Start by creating an export file 

An export file can be any data file that you create. For each list that can be exported, there are 

requirements for which fields are allowed and which fields are required. Before exporting a file, 

be sure to read the guidelines below and you may also want to check out “HELP” from the menu 

buttons. 

To export the information from QuickBooks 
1. Back up your QuickBooks company file. 

Importing data is not reversible, so creating a backup is a good way to make sure you have a 

sound copy of your data should you wish to start over. 

2. Setting up the Export file by displaying the Export file window 

 Go to File, click Utilities > Export > Lists To IIF Files > then choose from the list the 

Chart of Accounts (unfortunately, you have to choose each list separate) 

 You then have to save it (I usually choose the desktop because it is easy to locate) and 

remember to name it correctly. 
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Figure #5 

To Import the information into QuickBooks 
1. You will now be following the above instructions – just in reverse. 

2. Display the Import a File window AND following the path in blue below. 

 

3. Set up the import by specifying the import file “IIF FILES” and how the contents of the file 

should be mapped to your QuickBooks data.  (double click on the saved file) 

ms-its:C:/Program%20Files/Intuit/QuickBooks%202007/thirdparty_n.chm::/excel_n/task_create_mapping.html
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4. You should not need to preview the data because you are moving the information from one 

QB file to another. 

5. Then click on Chart of Accounts and choose Open.  The program should do the rest. 

Exporting your original Chart of Accounts 

Process 
1. Click File menu 

2. Utilities option 

3. Then move down to Export and then to List To IIF Files 

 

 

4. You will then get this screen and you will check the “Chart of Accounts” option and click 

OK button 
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5. The screen will give you the option to EXPORT the chart of accounts and it is preferable 

that you save it to YOUR DESKTOP.  MAKE SURE YOU NAME THE FILE – 

‘CHART OF ACCOUNTS” so that it will be easier to locate and IMPORT. 

 

 

6. Then reverse the steps above.  You will Import the files from the desktop 
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Online Banking Tips 

The following tips will help you use QBs Online Banking feature more efficiency. 

1. Backup Before downloading.  While it may not happen a great deal, sometimes when you 

bring over the transactions from your institution (banking/credit card company) not 

everything goes as planned.  Then if something were you happen, you can simply restore the 

backup company and the file will be as it was before you downloaded. 

 

2. Download New Transactions before Reconciling.  QBs is set up to only download 

transactions that have not been reconciled, even if it is the same transactions.   

 

 Only have one (1) QBs Online Banking Window Open.  Unfortunately, QBs will allow 

more than one banking window open at the same time which can make it very confusing 

when you add any new transactions.  To view what is open access the Open Window 

List.  To open this list: 

 Go to View > then Open Window List 

 The list of open windows will then be visible on the left side of the Home 

window  

 Select each window and click on the black “X” to close 

 

 

 

 

 

 

3. Understand Your Connections.  In QBs there are two (2) ways to download transactions: 

 The first way is through a “Web-connect.”  When using this type of connection the 

internal QB web browser opens and takes you to the financial institution’s website.  Once 

there > sign into your account, and navigate to the place where you can download 

transactions. 

 The second way is a Direct Connection. (typically your financial institution will charge 

for this service)  In this way QB asks for your password, then downloads transaction 

directly, without opening the WB web browser. 

 

4. Correct Dates for Download.  Sometimes your financial institution may not keep track of 

the last date you downloaded.  If yours doesn’t you will have to try to remember the last time 

you downloaded.  Always double check that you do not accidentally overlap dates or you 

will be downloading transactions twice. 
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5. Be Careful about Deleting the QuickStatement.  “QuickStatement” refers to the 

transactions that have been downloaded but not yet entered into QB.  Sometimes, the 

QuickStatement gets filled with unmatchable transactions and you can simply delete it.  

However, before deleting it, make sure that every transaction that can be matched, is 

matched.  If matchable transaction remain on the deleted QuickStatement you will have to 

enter them manually since many times your financial institution will not download them a 

second time. 

 


